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Developer Guide
The developer environment can be set in any Operating System (Linux, Windows, etc.) since it is a multi-platform
system, but Linux is recommended, because is what it is being used.
You need to install Maven, eclipse IDE and some plugins. For OpenKM 4.0 and 5.0 you have these requirements:
• Maven at http:/ / maven. apache. org/
• Eclipse Juno (Eclipse IDE for Java EE Developers) at http:/ / eclipse. org/ juno/
• Subversion eclipse plugin at http:/ / subclipse. tigris. org
• Maven to eclipse plugin at http:/ / m2eclipse. sonatype. org
• Java JDK 1.6 at http:/ / www. oracle. com/ technetwork/ java/ javase/ downloads/ index. html

Starting from Eclipse Galileo you have a Marketplace accessible from Help > Eclipse Marketplace... Here you can search for "maven" to
install the "Maven Integration for Eclipse" and "Maven Integration for Eclipse (Extras)" solutions. Also you can search for "subversion"
to find the "Subclipse" plugin.

The easier way to get an Eclipse installation with the required plugins is using JBoss Developer Studio.

Once all them are installed, you can download OpenKM and build it.
•• Configure Java in Eclipse
•• Configure tomcat server in Eclipse
•• Maven installation
•• Checkout source from Subversion
•• Development tips
•• Debug with tomcat
•• Debugging with GWT
• Profiling OpenKM 
• Doxygen OpenKM 5.0.x [1] ( OpenKM packages & classes & files documentation )
• Doxygen OpenKM 5.1.x [2] ( OpenKM packages & classes & files documentation )
Note: You can configure Eclipse to integrate with MantisBT. Read Mylyn-Mantis Repository Connecto [3]for more
info.

Eclipse Development Quick Install Guide
This quick install is valid for Eclipse Indigo.
1. Download Eclipse IDE for Java EE Developers from http:/ / www. eclipse. org/ downloads/ .
2. Go to Help > Eclipse Marketplace and install these plugins:

1. Maven Integration for Eclipse [4]

2. Subclipse [5]

Alternative: Add repository

• Subclipse 1.6.x Update Site -> http:/ / subclipse. tigris. org/ update_1. 6. x
• Maven Integration for Eclipse - http:/ / m2eclipse. sonatype. org/ sites/ m2e/
• Maven Integration for Eclipse Extras - http:/ / m2eclipse. sonatype. org/ sites/ m2e-extras/

http://maven.apache.org/
http://eclipse.org/juno/
http://subclipse.tigris.org
http://m2eclipse.sonatype.org
http://www.oracle.com/technetwork/java/javase/downloads/index.html
http://wiki.openkm.com/index.php?title=File:Nota_clasica.png
http://wiki.openkm.com/index.php?title=File:Nota_idea.png
http://wiki.openkm.com/index.php?title=Development_tips
http://wiki.openkm.com/index.php?title=File:Padlock.gif
http://doxygen.openkm.com/5.0.x
http://doxygen.openkm.com/5.1.x
http://sourceforge.net/apps/mediawiki/mylyn-mantis/index.php?title=Main_Page
http://www.eclipse.org/downloads/.
http://marketplace.eclipse.org/content/maven-integration-eclipse
http://marketplace.eclipse.org/content/subclipse
http://subclipse.tigris.org/update_1.6.x
http://m2eclipse.sonatype.org/sites/m2e/
http://m2eclipse.sonatype.org/sites/m2e-extras/
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Deprecated

OpenKM version 5.x and older
•• Configure JBoss server in Eclipse
•• Debugging remote server
•• Browsing embeded database
•• Debugging OpenKM with Jboss

Changelog

Changes between developer guide 5.0 to 6.0

•• GWT 2.4.0
•• OpenKM now is executed under tomcat
•• Changed to Eclipse Juno

Changes between developer guide 4.0 to 5.0

•• Development tips changes ( how to enable OpenKM extensions in compilation and disable automatic GWT
compilation )

•• GWT 2.0.4
•• Java package has been refactoring to "com.openkm" all references to older package in configuration files has been

changed

Changes between developer guide 2.0 to 4.0

•• Changed to Eclipse Galileo
•• Now we use maven in replacement of JBoss Tools

Changes between developer guide 1.2 to 2.0

•• Changed IDE to Eclipse Europa / JBoss tools, before was JBoss IDE.
•• GWT 1.5.3 is needed to compile, before was version 1.4.6
•• Changed packaging to new jboss tools packaging.
•• Changed GWT generating to temporary JBoss folder to project folders to developing.
•• Added new generateback.sh and generateback.bat to GWT admin.
•• Upgraded JBoss server to version 4.2.2.GA

Changes between developer guide 1.0 and 1.1 to 1.2

•• GWT 1.4.6 is needed to compile, before was version 1.3.3.
•• Changes on GWT shell configuration, now not uses GWTDS variable ( code deleted ).
•• Configured generate.sh to deploy to tmp JBoss with OpenKM.ear deployed to fast developing.
•• Added gecko to Main.gwt.xml to fast compiling only gecko when is uncommented.

References
[1] http:/ / doxygen. openkm. com/ 5. 0. x
[2] http:/ / doxygen. openkm. com/ 5. 1. x
[3] http:/ / sourceforge. net/ apps/ mediawiki/ mylyn-mantis/ index. php?title=Main_Page
[4] http:/ / marketplace. eclipse. org/ content/ maven-integration-eclipse
[5] http:/ / marketplace. eclipse. org/ content/ subclipse

http://doxygen.openkm.com/5.0.x
http://doxygen.openkm.com/5.1.x
http://sourceforge.net/apps/mediawiki/mylyn-mantis/index.php?title=Main_Page
http://marketplace.eclipse.org/content/maven-integration-eclipse
http://marketplace.eclipse.org/content/subclipse
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Configure Java in Eclipse
Go to Window / Preferences / Java / Installed JRE. You must have JDK 1.6 defined here:

http://wiki.openkm.com/index.php?title=File%3AOkm_dev_guide_004.jpeg
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http://wiki.openkm.com/index.php?title=File%3AOkm_dev_guide_005.jpeg
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Configure tomcat server in Eclipse
Go to servers tab Using contextual menus select Add / server. Select Tomcat 7 server:

Configure a new Run time server environment:

http://wiki.openkm.com/index.php?title=File:Okm_dev_guide_035.png
http://wiki.openkm.com/index.php?title=File:Okm_dev_guide_036.png
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• Checkbox Use Tomcat installation ( takes control of tomcat installation ).
• Increment startup and stop timeouts.

Edit launch configuration: Add sigar library path and utf-8 file enconding at arguments tab

-Djava.library.path="/your tomcat path/lib/sigar" -Xms128m -Xmx1024m 

-XX:PermSize=128m -XX:MaxPermSize=256m  -Djava.awt.headless=true 

-Dfile.encoding=utf-8

http://wiki.openkm.com/index.php?title=File:Okm_dev_guide_037.png
http://wiki.openkm.com/index.php?title=File:Okm_dev_guide_038.png
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Add your openkm project at source tab

Add CATALINA_PID and LD_LIBRARY_PATH environement variables:

CATALINA_PID=$CATALINA_HOME/catalina.pid

LD_LIBRARY_PATH=$LD_LIBRARY_PATH:$CATALINA_HOME/lib/sigar:/usr/local/apr/lib

http://wiki.openkm.com/index.php?title=File:Okm_dev_guide_039.png
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Maven installation
Maven is a software tool for Java project management and build automation. It is similar in functionality to the
Apache Ant tool, but is based on different concepts. Maven is hosted by the Apache Software Foundation, where it
was formerly part of the Jakarta Project.
Maven uses a construct known as a Project Object Model (POM) to describe the software project being built, its
dependencies on other external modules and components, and the build order. It comes with pre-defined targets for
performing certain well defined tasks such as compilation of code and its packaging.
In GNU/Linux you can add the Maven executable to the binary path editing the $HOME/.bashrc file and adding this
line at the end:

export PATH=$PATH:/path/to/maven/installation/bin

export MAVEN_OPTS="-Xmx512m"

Learn more about Maven at http:/ / maven. apache. org.

http://wiki.openkm.com/index.php?title=File:Okm_dev_guide_040.png
http://maven.apache.org.
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Register missing Maven dependencies
Although project dependencies usually at located at Maven repositories, sometimes there are missing artifacts. So,
we have to provide these libraries registering them in the local Maven repository. Follow these steps to register some
libraries needed by OpenKM:
•• Open an operating system console.
•• Go to OpenKM project path in your local file system.
• Drive into ext-libs and execute install.sh (Windows users simply open this file with text editor and execute the

command)

Starting with OpenKM 5.0, you don't need to register manually these dependencies.

Some Maven tips
Download sources and javadoc from libraries dependency to improve the developer experience:

$ mvn install -DdownloadSources=true  -DdownloadJavadocs=true

You can make Maven ignore test failures in the build process this way:

$ mvn install -Dmaven.test.failure.ignore=true

If you would like to skip tests, you can do so by executing the following command:
$ mvn install -Dmaven.test.skip=true

http://wiki.openkm.com/index.php?title=File:Nota_clasica.png
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Checkout source from Subversion
Go to File / New / Other and select Maven / Checkout Maven Projects from SCM:
Hint: If your SCM dropdown list is empty, install the Maven Subclipse extension from (http:/ / m2eclipse. sonatype.
org/ sites/ m2e-extras/ ).

SourceForge has updated some of its features and the OpenKM Subversion repository has changed. To get the source code: svn checkout
[1] openkm-code

Select the svn type and type the url http:/ / svn. code. sf. net/ p/ openkm/ code/ branches/ 6. 2/ openkm to refer
version 6.2:
Select the svn type and type the url https:/ / openkm. svn. sourceforge. net/ svnroot/ openkm/ branches/ 5. 1/ openkm
to refer version 5.1:
Select the svn type and type the url https:/ / openkm. svn. sourceforge. net/ svnroot/ openkm/ branches/ 5. 0/ openkm
to refer version 5.0:
Select the svn type and type the url https:/ / openkm. svn. sourceforge. net/ svnroot/ openkm/ branches/ 4. 1/ openkm
to refer version 4.1:
Select the svn type and type the url https:/ / openkm. svn. sourceforge. net/ svnroot/ openkm/ branches/ 4. 0/ openkm
to refer version 4.0:

http://m2eclipse.sonatype.org/sites/m2e-extras/).
http://m2eclipse.sonatype.org/sites/m2e-extras/).
http://wiki.openkm.com/index.php?title=File%3AOkm_dev_guide_001.jpeg
http://wiki.openkm.com/index.php?title=File:Nota_clasica.png
http://svn.code.sf.net/p/openkm/code/branches/6.2/openkm
http://svn.code.sf.net/p/openkm/code/branches/6.2/openkm
https://openkm.svn.sourceforge.net/svnroot/openkm/branches/5.1/openkm
https://openkm.svn.sourceforge.net/svnroot/openkm/branches/5.0/openkm
https://openkm.svn.sourceforge.net/svnroot/openkm/branches/4.1/openkm
https://openkm.svn.sourceforge.net/svnroot/openkm/branches/4.0/openkm
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Be patient, first time you downloading OpenKM from svn, you're downloading all libraries to your maven
repository. It could take several minutes depending your Internet connection.

After OpenKM will be downloaded, and automatically compiled.

If you want native support for Subversion, you have to install the libsvn-java package in Linux. The edit the eclipse.ini configuration file
and add the following line:

-Djava.library.path=/usr/lib/jni

References
[1] http:/ / svn. code. sf. net/ p/ openkm/ code/ branches/ 6. 2/ openkm

http://wiki.openkm.com/index.php?title=File:Okm_dev_guide_002.jpeg
http://wiki.openkm.com/index.php?title=File:Okm_dev_guide_003.jpeg
http://wiki.openkm.com/index.php?title=File%3AOkm_dev_guide_006.jpeg
http://wiki.openkm.com/index.php?title=File:Nota_clasica.png
http://svn.code.sf.net/p/openkm/code/branches/6.2/openkm
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JBoss Developer Studio
You can get a free copy of JBoss Developer Studio from http:/ / www. jboss. com/ products/ devstudio/ . Once
registered you can download the program compiled for your preferred Operating System.
In order to install Maven and Subversion integration, go to Help > Install New Software... and select:

"JBoss Developer Studio 4.0 Extras - https:/ / devstudio. jboss. com/ updates/ 4. 0/ extras/ "

Open "JBoss Selected Features" and select
•• Maven Integration
•• Subclipse
Once selected, click on the Next button and follow the installation wizard until finished. In the last step JBoss Studio
need to be restarted.
When you import a Subversion project, you will see this dialog:

The first time you will need to install the Subversion connector from the m2e Marketplace. Go to the m2e Team
providers group and select m2e-subclipse. After that, click on the Finish button.

http://www.jboss.com/products/devstudio/.
https://devstudio.jboss.com/updates/4.0/extras/
http://wiki.openkm.com/index.php?title=File%3AJBoss_Developer_Subversion_Import.png
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Development tips OpenKM 6.0
We recommend downloading Tomcat+OpenKM from SourceForge, remove OpenKM.war and develop with this
JBoss server configuration. For better development we recommend not deploying OpenKM.war file it's better setting
in $TOMCAT_HOME/webapps some alias to target/OpenKM folder:

To create symbolic links in windows use juntion.exe [1]

In case you're making strong changes in OpenKM UI (GWT) we recommend disabling pom compile directive

<plugins>

      <plugin>

        <groupId>org.codehaus.mojo</groupId>

        <artifactId>gwt-maven-plugin</artifactId>

        <version>${gwt.version}</version>

        <executions>

          <execution>

            <goals>

              <goal>compile</goal>

              <!-- <goal>generateAsync</goal> -->

              <!-- <goal>test</goal> -->

            </goals>

          </execution>

        </executions>

        <configuration>

          <runTarget>com.openkm.frontend.Main/index.html</runTarget>

          <modules>

            <module>com.openkm.frontend.Main</module>

http://wiki.openkm.com/index.php?title=File%3AOkm_dev_guide_041.png
http://wiki.openkm.com/index.php?title=File:Nota_clasica.png
http://technet.microsoft.com/en-us/sysinternals/bb896768
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          </modules>

          <localWorkers>4</localWorkers>

        </configuration>

      </plugin>

Important, depending the number of cores and memory decrease the number of gwt instances compiled at same time decreasing
locarlWorkers, otherside your computer may hang

Is possible to compile GWT modules individually by this way:

$ mvn gwt:compile -Dgwt.module=com.openkm.frontend.Main

You might be interested in running frontend and backend GWT packaging from eclipse. Go to run configurations
and add in maven build

http://wiki.openkm.com/index.php?title=File:Nota_clasica.png
http://wiki.openkm.com/index.php?title=File:Nota_idea.png
http://wiki.openkm.com/index.php?title=File%3AOkm_dev_guide_031.jpeg
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To achieve a faster compile we use to development Firefox, uncommenting gecko line on file Main.gwt.xml GWT
compilation only for gecko browser runs fine. Don't forget at finish to comment it and try application with IE or
other browsers.

<!-- Compile for Firefox only -->

<set-property name="user.agent" value="gecko"/>

User contribution script modified to tomcat deploy
#!/bin/bash

# @author: Kenneth Walter

#Cleans and re-compiles the source files

mvn -Dmaven.test.skip=true clean gwt:compile install $*

#Set the TARGET_DIRECTORY to the path of your JBoss installation

TARGET_DIRECTORY=~/Downloads/tomcat-7.0.27/

FILE_TO_MOVE=target/OpenKM.war

#This will only attempt to replace the existing WAR if the new WAR 

exists

if [ -f $FILE_TO_MOVE ]

then

   echo 'Deploying WAR to JBoss Directory'

   cp -v $FILE_TO_MOVE $TARGET_DIRECTORY/webapps/.

   echo 'Done'

fi

More info about this script at Cannot create or use example extensions [2] forum thread.

http://wiki.openkm.com/index.php?title=File%3AOkm_dev_guide_032.jpeg
http://forum.openkm.com/viewtopic.php?f=31&amp;t=5332
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References
[1] http:/ / technet. microsoft. com/ en-us/ sysinternals/ bb896768
[2] http:/ / forum. openkm. com/ viewtopic. php?f=31& t=5332

Development tips OpenKM 5.1
We recommend downloading JBoss+OpenKM from SourceForge, remove OpenKM.war and develop with this JBoss
server configuration. For better development we recommend not deploying OpenKM.war file it's better setting in
$JBOSS_HOME/server/default/deploy some alias to target/OpenKM folder:

To create symbolic links in windows use juntion.exe [1]

In case you're making strong changes in OpenKM UI (GWT) we recommend disabling pom compile directive

<plugins>

      <plugin>

        <groupId>org.codehaus.mojo</groupId>

        <artifactId>gwt-maven-plugin</artifactId>

        <version>${gwt.version}</version>

        <executions>

          <execution>

            <goals>

              <goal>compile</goal>

              <!-- <goal>generateAsync</goal> -->

              <!-- <goal>test</goal> -->

            </goals>

          </execution>

        </executions>

        <configuration>

http://technet.microsoft.com/en-us/sysinternals/bb896768
http://forum.openkm.com/viewtopic.php?f=31&amp;t=5332
http://wiki.openkm.com/index.php?title=File%3AOkm_dev_guide_011.jpeg
http://wiki.openkm.com/index.php?title=File:Nota_clasica.png
http://technet.microsoft.com/en-us/sysinternals/bb896768
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          <runTarget>com.openkm.frontend.Main/index.html</runTarget>

          <modules>

            <module>com.openkm.frontend.Main</module>

          </modules>

          <localWorkers>4</localWorkers>

        </configuration>

      </plugin>

Important, depending the number of cores and memory decrease the number of gwt instances compiled at same time decreasing
locarlWorkers, otherside your computer may hang

Is possible to compile GWT modules individually by this way:

$ mvn gwt:compile -Dgwt.module=com.openkm.frontend.Main

You might be interested in running frontend and backend GWT packaging from eclipse. Go to run configurations
and add in maven build

http://wiki.openkm.com/index.php?title=File:Nota_clasica.png
http://wiki.openkm.com/index.php?title=File:Nota_idea.png
http://wiki.openkm.com/index.php?title=File%3AOkm_dev_guide_031.jpeg
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To achieve a faster compile we use to development Firefox, uncommenting gecko line on file Main.gwt.xml GWT
compilation only for gecko browser runs fine. Don't forget at finish to comment it and try application with IE or
other browsers.

<!-- Compile for Firefox only -->

<set-property name="user.agent" value="gecko"/>

User contribution script
#!/bin/bash

# @author: Kenneth Walter

#Cleans and re-compiles the source files

mvn -Dmaven.test.skip=true clean gwt:compile install $*

#Set the TARGET_DIRECTORY to the path of your JBoss installation

TARGET_DIRECTORY=~/Downloads/jboss-4.2.3.GA/

FILE_TO_MOVE=target/OpenKM.war

#This will only attempt to replace the existing WAR if the new WAR 

exists

if [ -f $FILE_TO_MOVE ]

then

   echo 'Deploying WAR to JBoss Directory'

   cp -v $FILE_TO_MOVE $TARGET_DIRECTORY/server/default/deploy/.

   echo 'Done'

fi

More info about this script at Cannot create or use example extensions [2] forum thread.

http://wiki.openkm.com/index.php?title=File%3AOkm_dev_guide_032.jpeg
http://forum.openkm.com/viewtopic.php?f=31&amp;t=5332
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Development tips OpenKM 5.0
We recommend downloading JBoss+OpenKM from SourceForge, remove OpenKM.war and develop with this JBoss
server configuration. For better development we recommend not deploying OpenKM.war file it's better setting in
$JBOSS_HOME/server/default/deploy some alias to target/OpenKM folder:

To create symbolic links in windows use juntion.exe [1]

It's mandatory registering sample-5.0-full.jar into maven repository. File is into ext-libs folder. It must be executed
some maven command to registering ( then compilation will execute right ). Take a look at install.sh, if sometimes is
required some new library, the reference it'll be included on that file.
mvn install:install-file -DgroupId=com.openkm.extension -DartifactId=sample-full -Dversion=5.0 -Dpackaging=jar -Dfile=sample-5.0-full.jar

In case you're making strong changes in OpenKM UI (GWT) we recommend disabling pom compile directive

<plugin>

        <groupId>org.codehaus.mojo</groupId>

        <artifactId>gwt-maven-plugin</artifactId>

        <version>1.2</version>

        <executions>

          <execution>

            <goals>

              <goal>compile</goal>

              <!-- <goal>generateAsync</goal> -->

              <!-- <goal>test</goal> -->

            </goals>

          </execution>

        </executions>

        <configuration>

          <runTarget>com.openkm.frontend.Main/index.html</runTarget>

http://wiki.openkm.com/index.php?title=File%3AOkm_dev_guide_011.jpeg
http://wiki.openkm.com/index.php?title=File:Nota_clasica.png
http://technet.microsoft.com/en-us/sysinternals/bb896768


Development tips OpenKM 5.0 20

          <modules>

            <module>com.openkm.frontend.Main</module>

          </modules>

        </configuration>

      </plugin>

Is possible to compile GWT modules individually by this way:

$ mvn gwt:compile -Dgwt.module=com.openkm.frontend.Main

You might be interested in running frontend and backend GWT packaging from eclipse. Go to run configurations
and add in maven build

http://wiki.openkm.com/index.php?title=File:Nota_idea.png
http://wiki.openkm.com/index.php?title=File%3AOkm_dev_guide_031.jpeg
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To achieve a faster compile we use to development Firefox, uncommenting gecko line on file Main.gwt.xml GWT
compilation only for gecko browser runs fine. Don't forget at finish to comment it and try application with IE or
other browsers.

<!-- Compile for Firefox only -->

<set-property name="user.agent" value="gecko"/>

User contribution script
#!/bin/bash

# @author: Kenneth Walter

#Cleans and re-compiles the source files

mvn -Dmaven.test.skip=true clean gwt:compile install $*

#Set the TARGET_DIRECTORY to the path of your JBoss installation

TARGET_DIRECTORY=~/Downloads/jboss-4.2.3.GA/

FILE_TO_MOVE=target/OpenKM.war

#This will only attempt to replace the existing WAR if the new WAR 

exists

if [ -f $FILE_TO_MOVE ]

then

   echo 'Deploying WAR to JBoss Directory'

   cp -v $FILE_TO_MOVE $TARGET_DIRECTORY/server/default/deploy/.

   echo 'Done'

fi

More info about this script at Cannot create or use example extensions [2] forum thread.

http://wiki.openkm.com/index.php?title=File%3AOkm_dev_guide_032.jpeg
http://forum.openkm.com/viewtopic.php?f=31&amp;t=5332
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Development tips OpenKM 4.0
We recommend downloading JBoss+OpenKM from SourceForge, remove OpenKM.war and develop with this JBoss
server configuration. For better development we recommend not deploying OpenKM.war file it's better setting in
$JBOSS_HOME/server/default/deploy some alias to target/OpenKM folder:

To create symbolic links in windows use juntion.exe [1]

In case you're making strong changes in OpenKM UI (GWT) we recommend disabling pom compile directive

<plugin>

    <groupId>org.codehaus.mojo</groupId>

        <artifactId>gwt-maven-plugin</artifactId>

        <version>1.1</version>

        <configuration>

            <runTarget>es.git.openkm.frontend.Main/index.html</runTarget>

        </configuration>

        <executions>

          <execution>

            <goals>

               <!-- <goal>compile</goal> -->

              <!-- <goal>generateAsync</goal>  -->

              <goal>test</goal>

            </goals>

          </execution>

        </executions>

    </plugin>

http://wiki.openkm.com/index.php?title=File%3AOkm_dev_guide_011.jpeg
http://wiki.openkm.com/index.php?title=File:Nota_clasica.png
http://technet.microsoft.com/en-us/sysinternals/bb896768
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Is possible to compile GWT modules individually by this way:

$ mvn gwt:compile -Dgwt.module=com.openkm.backend.Main

You might be interested in running frontend and backend GWT packaging from eclipse. Go to run configurations
and add in maven build

http://wiki.openkm.com/index.php?title=File:Nota_idea.png
http://wiki.openkm.com/index.php?title=File%3AOkm_dev_guide_012.jpeg
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To achieve a faster compile we use to development Firefox, uncommenting gecko line on file Main.gwt.xml GWT
compilation only for gecko browser runs fine. Don't forget at finish to comment it and try application with IE or
other browsers. Now are two files called Main.gwt.xml one for frontend and other to backend.

<!-- Compile for Firefox only -->

<set-property name="user.agent" value="gecko"/>

http://wiki.openkm.com/index.php?title=File%3AOkm_dev_guide_013.jpeg
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Debug with tomcat
You can debug your OpenKM installation using the Tomcat logging facility. This is an useful thing when you have
problems with your configuration. Default OpenKM installation tries to log important events like errors and
warnings. Is possible to change this configuration editing the file $TOMCAT_HOME/conf/logging.properties.
Default Tomcat log configuration can generate a lot of messages. These files are stored at $TOMCAT_HOME/logs.

Debugging with GWT
Go to run configurations and add new java application configuration as you can see in this screenshoot.
First of all, open the pom.xml file and uncomment this section:

<!-- Only for development --> 

<dependency> 

   <groupId>com.google.gwt</groupId>

   <artifactId>gwt-dev</artifactId>

   <version>${gwt.version}</version>

   <scope>provided</scope>

</dependency>

Set the Main class:

com.google.gwt.dev.DevMode

Set program arguments

-port 8080 -noserver -startupUrl  /OpenKM/frontend/index.jsp com.openkm.frontend.Main

and the VM arguments

http://wiki.openkm.com/index.php?title=File:Okm_dev_guide_014.jpeg


Debugging with GWT 26

-Xms1024m -Xmx1024M

Set the jdk 1.6

Set the class path. Pay special attention in adding folder /openkm/src/main ( using button advanced and add folder
option )

http://wiki.openkm.com/index.php?title=File:Okm_dev_guide_034.jpeg
http://wiki.openkm.com/index.php?title=File:Okm_dev_guide_016.jpeg


Debugging with GWT 27

Now you can run ( better if you run in debug mode, you can set breakpoints in your eclipse code ). It'll appear some
screen like this:

To debug login put in your browser

http:/ / localhost:8080/ OpenKM/ frontend/ index. jsp?gwt. codesvr=127. 0. 1. 1:9997

To debug frontend first authenticate and after it, put in your browser

http:/ / localhost:8080/ OpenKM/ frontend/ index. html?gwt. codesvr=127. 0. 1. 1:9997

http://wiki.openkm.com/index.php?title=File:Okm_dev_guide_017.jpeg
http://wiki.openkm.com/index.php?title=File:Okm_dev_guide_017.jpeg
http://localhost:8080/OpenKM/frontend/index.jsp?gwt.codesvr=127.0.1.1:9997
http://localhost:8080/OpenKM/frontend/index.html?gwt.codesvr=127.0.1.1:9997
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You debug into eclipse, see variables values etc...

http://wiki.openkm.com/index.php?title=File:Okm_dev_guide_018.jpeg
http://wiki.openkm.com/index.php?title=File:Okm_dev_guide_019.jpeg
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http://wiki.openkm.com/index.php?title=File:Okm_dev_guide_020.jpeg
http://wiki.openkm.com/index.php?title=File:Okm_dev_guide_021.jpeg
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OpenKM version 4.1 and older
Set the program arguments

-port 8080 -noserver -startupUrl  /OpenKM/com.openkm.frontend.Main/index.html com.openkm.frontend.Main

To debug login put in your browser

http:/ / localhost:8080/ OpenKM/ com. openkm. login. Main/ index. jsp?gwt. codesvr=127. 0. 1. 1:9997

To debug frontend first authenticate and after it, put in your browser

http:/ / localhost:8080/ OpenKM/ com. openkm. frontend. Main/ index. html?gwt. codesvr=127. 0. 1. 1:9997

Profiling OpenKM
You can profiling local and remote Java applications using Java VisualVM [1]. For local application is easy because
it detect automatically them and show in the listing. For remote application you need to do a little work.
First of all add this line to $TOMCAT_HOME/bin/setenv.sh file (or setenv.bat if using Windows):

CATALINA_OPTS="$CATALINA_OPTS -Dcom.sun.management.jmxremote=true"

CATALINA_OPTS="$CATALINA_OPTS -Dcom.sun.management.jmxremote.port=9090"

CATALINA_OPTS="$CATALINA_OPTS -Dcom.sun.management.jmxremote.ssl=false"

CATALINA_OPTS="$CATALINA_OPTS 

-Dcom.sun.management.jmxremote.authenticate=false"

CATALINA_OPTS="$CATALINA_OPTS -Djava.rmi.server.hostname=127.0.0.1"

The java.rmi.server.hostname should match the internal IP of the remote server, so replace 127.0.0.1 by the right IP.

In order to connect to this remote Tomcat instance, go to File > Add JMX Connection... and fill the hostname and
port. In this case the port is 9090 but you can set another one using the com.sun.management.jmxremote.port
property.

Authentication
To enhance security, enable authentication:

CATALINA_OPTS="$CATALINA_OPTS 

-Dcom.sun.management.jmxremote.authenticate=true"

CATALINA_OPTS="$CATALINA_OPTS 

-Dcom.sun.management.jmxremote.password.file=$CATALINA_HOME/conf/jmxremote.password"

CATALINA_OPTS="$CATALINA_OPTS 

-Dcom.sun.management.jmxremote.access.file=$CATALINA_HOME/conf/jmxremote.access"

Edit the access allow file $CATALINA_HOME/conf/jmxremote.access:

 monitorRole readonly

 controlRole readwrite

To show remote threads you need the readwrite permission.

http://localhost:8080/OpenKM/com.openkm.login.Main/index.jsp?gwt.codesvr=127.0.1.1:9997
http://localhost:8080/OpenKM/com.openkm.frontend.Main/index.html?gwt.codesvr=127.0.1.1:9997
http://docs.oracle.com/javase/6/docs/technotes/guides/visualvm/index.html
http://wiki.openkm.com/index.php?title=File:Nota_clasica.png
http://wiki.openkm.com/index.php?title=File:Nota_clasica.png
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Edit the password file $CATALINA_BASE/conf/jmxremote.password :

 monitorRole tomcat

 controlRole tomcat

And finally, restrict access to these files:

 $ chmod 600 $CATALINA_HOME/conf/jmxremote.access

 $ chmod 600 $CATALINA_HOME/conf/jmxremote.password

Monitoring Remote JVM Over SSH
The easiest way to connect to the remote JMX is to use a SOCKS proxy [2].

 $ ssh user@external.server.ip -D 8888

You need to configure VisualVM to use this proxy. Go to Tools > Options > Network and edit Manual Proxy
Settings. Configure SOCKS Proxy at localhost and port 8888.

Now you can connect VisualVM to the remote target. Go to File > Add JMX Connection... and type the IP or
hostname of the remote machine and the configured JMX port (in our sample configuration is 9090).

http://en.wikipedia.org/wiki/SOCKS
http://wiki.openkm.com/index.php?title=File%3AVisualvm_proxy.png
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More info:
• Profiling With VisualVM, Part 1 [3]

• Profiling With VisualVM, Part 2 [4]

• Connecting Visual VM to Tomcat 7 [5]

• Monitoring and Managing Tomcat 7 [6]

• Remote Profiling of JBoss using VisualVM [7]

• Troubleshooting application performance with VisualVM [8]

• Monitoring of Tomcat with VisualVM and VisualGC [9]

• Using VisualVM to fix live Tomcat and JVM problems [10]

HPROF
Java includes HPROF, a profiler which collect application runtime information. HPROF is capable of presenting
CPU usage, heap allocation statistics, and monitor contention profiles.
For example, can collect CPU usage information by sampling threads. Add this line to
$TOMCAT_HOME/bin/setenv.sh file (or setenv.bat if using Windows):

CATALINA_OPTS="$CATALINA_OPTS -agentlib:hprof=cpu=samples"

When Tomcat starts you can see a file called java.hprof.txt. The CPU profiling info will be dumped to this file once
Tomcat process is stopped.
More info:
• HPROF: A Heap/CPU Profiling Tool in J2SE 5.0 [11]

• HPjmeter [12]

http://wiki.openkm.com/index.php?title=File%3AVisualvm_jmx.png
https://blogs.oracle.com/nbprofiler/entry/profiling_with_visualvm_part_1
https://blogs.oracle.com/nbprofiler/entry/profiling_with_visualvm_part_2
http://blog.markwshead.com/1129/connecting-visual-vm-to-tomcat-7/
http://tomcat.apache.org/tomcat-7.0-doc/monitoring.html
http://hillert.blogspot.com.es/2010/01/remote-profiling-of-jboss-using.html
http://www.skill-guru.com/blog/2010/11/11/troubleshooting-application-performance-with-visualvm/
http://techblog.zabuchy.net/2012/monitoring-of-tomcat-with-visualvm-and-visualgc/
http://blog.tty.nl/2010/09/03/using-visualvm-to-fix-live-tomcat-and-jvm-problems/
http://java.sun.com/developer/technicalArticles/Programming/HPROF.html
https://h20392.www2.hp.com/portal/swdepot/displayProductInfo.do?productNumber=HPJMETER
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OpenKM 5.x and older

Configure JBoss server in Eclipse
Go to servers tab Using contextual menus select Add / server. Select JBoss server:

Debugging remote server
If you got problems on production environment this configuration is specially useful.
OpenKM 6.x - Tomcat

Add the following options when the JVM is started:

-Xdebug -Xrunjdwp:transport=dt_socket,address=8000,server=y,suspend=n

If you are using shell scripts to start Tomcat, start it with the following command:

$ $TOMCAT_HOME/bin/catalina.sh jpda start

It will start Tomcat so that a remote debugger can be connected to port 8000.
For more info read Tomcat developing: How do I configure Tomcat to support remote debugging? [1].
OpenKM 5.1 - JBoss

Add this line at the top of $JBOSS_HOME/bin/run.sh script:

JAVA_OPTS="-Xmx2000m -Djava.awt.headless=true -Xdebug -Xnoagent 

-Xrunjdwp:transport=dt_socket,server=y,suspend=n,address=8000"

http://wiki.openkm.com/index.php?title=File:Okm_dev_guide_007.jpeg
http://wiki.openkm.com/index.php?title=File:Okm_dev_guide_008.jpeg
http://wiki.openkm.com/index.php?title=File:Okm_dev_guide_009.jpeg
http://wiki.openkm.com/index.php?title=File:Okm_dev_guide_010.jpeg
http://wiki.apache.org/tomcat/FAQ/Developing#Q1
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Configure Eclipse
Select the project and the host. Include in source your OpenKM java project. You can debug normally, setting
breakpoints etc...

http://wiki.openkm.com/index.php?title=File%3AOkm_user_guide_073.jpeg


Debugging remote server 36

See also Como hacer debug remoto en Tomcat desde Eclipse [2].
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Browsing embeded database
OpenKM comes with FOUR embeded databases that are defined in poll openkm-ds.xml into
$JBOSS_HOME/server/default/deploy directory
•• OKMActivity ( used for log info )
•• OKMAuth ( user for authentication purpose )
•• OKMDashboardStats ( used for dashboard info )
•• OKMWorkflow ( used to store workflow info )

A simply way to browse it
Check the JAVA_OPTS in bin/run.sh. java.awt.headless has to be false to use the embedded database browser.
An example JAVA_OPTS could be:

 JAVA_OPTS="-Xms256m -Xmx1024m -XX:PermSize=64m -XX:MaxPermSize=128m -Djava.awt.headless=false"

Open the url from server http:/ / localhost:8080/ jmx-console/ . You'll see there three services defined under JBoss:

database=OKMActivity,service=Hypersonic

database=OKMAuth,service=Hypersonic

database=OKMDashboardStats,service=Hypersonic

database=OKMWorkflow,service=Hypersonic

database=localDB,service=Hypersonic

Select one datasource, then look for void startDatabaseManager() and press the Invoke button. You will see an
screen like this:

More info at Starting hsqldb manager on JBoss [1].

http://localhost:8080/jmx-console/.
http://wiki.openkm.com/index.php?title=File%3AOkm_005.jpeg
http://docs.jboss.org/jbpm/v3/userguide/thejbpmdatabase.html#d0e2677
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Debugging OpenKM with Jboss
You can debug your OpenKM installation using the JBoss logging facility. This is an useful thing when you have
problems with your configuration. Default OpenKM installation tries to log important events like errors and
warnings. Is possible to change this configuration editing the file
$JBOSS_HOME/server/default/conf/jboss-log4j.xml.
Default JBoss log configuration can generate a lot of messages. These files are stored at
$JBOSS_HOME/server/default/log. It is configured to use the DailyRollingFileAppender. This appender create a
new log file for every day. This is better than have a unique huge log file, os course. The rollover is performed at
midnight each day, but you can configure it to make the rollover every hour (uncomment the proper line).

<!-- A time/date based rolling appender -->

<appender name="FILE"

          class="org.jboss.logging.appender.DailyRollingFileAppender">

   <errorHandler class="org.jboss.logging.util.OnlyOnceErrorHandler"/>

   <param name="File" value="${jboss.server.log.dir}/server.log"/>

   <param name="Append" value="false"/>

   <!-- Rollover at midnight each day -->

   <param name="DatePattern" value="'.'yyyy-MM-dd"/>

   <!-- Rollover at the top of each hour

   <param name="DatePattern" value="'.'yyyy-MM-dd-HH"/>

   -->

   <layout class="org.apache.log4j.PatternLayout">

      <!-- The default pattern: Date Priority [Category] Message\n -->

      <param name="ConversionPattern" value="%d %-5p [%c] %m%n"/>

      <!-- The full pattern: Date MS Priority [Category] (Thread:NDC) Message\n

      <param name="ConversionPattern" value="%d %-5r %-5p [%c] (%t:%x) %m%n"/>

      -->

   </layout>

</appender>

You can reduce the amount of log messages produced by OpenKM, or can increase them. In this example we limit
the log messages produced by the class OKMAccessManager for those of type ERROR.

<category name="com.openkm.core.OKMAccessManager">

   <priority value="ERROR" />

</category>

If you create this configuration:

<category name="com.openkm">

   <priority value="DEBUG" />

</category>

All the log messages generated by OpenKM will be shown. As you can see, you can increase debug messages in
some parts of OpenKM to check a determinate behavior.

http://docs.jboss.org/jbpm/v3/userguide/thejbpmdatabase.html#d0e2677
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Debugging JAAS configuration
If you are trying to setup another authentication source different from the default provided by OpenKM, you can
afford some problems. The JBoss login-config.xml is supposed to have the right configuration, but you can't log into
the application. The most common case is a bad or missing JAAS configuration. So if you need to debug the JAAS,
you can add to the $JBOSS_HOME/server/default/conf/jboss-log4j.xml file the following:

<category name="org.jboss.security">

   <priority value="TRACE" class="org.jboss.logging.XLevel"/>

   <appender-ref ref="SECURITY_F"/>

</category>

<appender name="SECURITY_F" class='org.jboss.logging.appender.DailyRollingFileAppender'>

   <param name="Append" value="true"/>

   <param name="DatePattern" value="'.'yyyy-MM-dd"/>

   <param name="File" value="${jboss.server.home.dir}/log/jboss.security.log"/>

   <layout class="org.apache.log4j.PatternLayout">

      <param name="ConversionPattern" value="%d{ABSOLUTE} %-5p [%c] %m%n"/>

   </layout>

</appender>

This is more or less in the middle of the file, just where the <category-name> section begins. And you should look at
this new log file:

$ tailf -f $JBOSS_HOME/server/default/log/jboss.security.log

Email error notification
Always is good idea to be notified when things goes wrong. There are some log appenders that can help you. The
SMTPAppender will mail you log messages with threshold ERROR by default. You can lower this threshold, but
you will got lots of useless mail messages. Here you must configure some properties:
• To: The mail account where the messages will arrive.
• From: You can set it simply as noreply@your-domain.com.
• Subject: Here you can specify the subject of the mail. If you have several OpenKM installations, you can create a

filter in your mail client using this value.
• SMTPHost: The mail server server. Can be localhost if there is a mail server installed in this computer.

<!-- EMail events to an administrator -->

<appender name="SMTP" class="org.apache.log4j.net.SMTPAppender">

  <errorHandler class="org.jboss.logging.util.OnlyOnceErrorHandler"/>

  <param name="Threshold" value="ERROR"/>

  <param name="To" value="admin@myhost.domain.com"/>

  <param name="From" value="nobody@myhost.domain.com"/>

  <param name="Subject" value="JBoss Sever Errors"/>

  <param name="SMTPHost" value="localhost"/>

  <param name="BufferSize" value="10"/>

  <layout class="org.apache.log4j.PatternLayout">

     <param name="ConversionPattern" value="[%d{ABSOLUTE},%c{1}] %m%n"/>

  </layout>

</appender>
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In Unix / Linux systems there is a centralized log manager called syslog. You can configure Log4J to use this system
using the SyslogAppender:

<!-- Syslog events -->

<appender name="SYSLOG" class="org.apache.log4j.net.SyslogAppender">

  <errorHandler class="org.jboss.logging.util.OnlyOnceErrorHandler"/>

  <param name="Facility" value="LOCAL7"/>

  <param name="FacilityPrinting" value="true"/>

  <param name="SyslogHost" value="localhost"/>

  <layout class="org.apache.log4j.PatternLayout">

     <param name="ConversionPattern" value="[%d{ABSOLUTE},%c{1}] %m%n"/>

  </layout>

</appender>

• SyslogHost: This configuration parameters allows you to specify the local syslog or a remote syslog server used
to centralize the network log management.

For more info, visit:
• http:/ / jboss. org/ community/ docs/ DOC-11280
• http:/ / jboss. org/ community/ docs/ DOC-9372
• http:/ / jakarta. apache. org/ log4j
• http:/ / primalcortex. wordpress. com/ 2007/ 11/ 28/ jboss-and-jaas-debug
• can I get log4j to delete old rotating log files? [1]
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